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About this book
Subject

This book describes RFID Anywhere Enterprise Manager, a standalone management tool providing
dynamic, standards-based management for distributed RFID Anywhere networks.

Audience
This book is for administrators of RFID Anywhere.

Before you begin
This book assumes a familiarity with RFID Anywhere and its associated management tasks, such as
provisioning and configuring RFID Anywhere components.
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RFID Anywhere documentation
This book is part of the RFID Anywhere documentation set. This section describes the materials in the
documentation set and how you can use them.

The RFID Anywhere documentation set
The RFID Anywhere documentation set consists of the following components:

● RFID Anywhere Getting Started Guide This book describes RFID Anywhere, a platform for
building RFID solutions. It provides instructions on installing and configuring RFID Anywhere, as well
as tutorials that demonstrate how you can use RFID Anywhere to administer and test your RFID network.

● RFID Anywhere Developer's Guide This book introduces common development tasks often
undertaken when working with RFID Anywhere. It describes the RFID Anywhere Visual Studio
Extension for creating custom business modules, introduces commonly-used interfaces for hardware and
component interaction, and outlines how to write Data Protocol Processors (DPPs).

● RFID Anywhere Enterprise Manager Guide This book describes RFID Anywhere Enterprise
Manager, a standalone management tool providing dynamic, standards-based management for
distributed RFID Anywhere networks.

● RFID Anywhere Mobile Support Guide This manual outlines RFID Anywhere's mobile device
support and development model.

● RFID Anywhere Location Information System Guide This book describes RFID Anywhere's
Location Information System (LIS). Using RFID Anywhere and LIS, businesses can not only track assets
from a range of data collection points [such as passive RFID, active RFID, real-time location systems
(RTLS), barcode, global positioning systems (GPS) and environmental sensors], but can dramatically
enhance the value of this data by associating environmental inputs (e.g., temperature) along with the
location data. In addition, the RFID Anywhere Location Information System exposes its complete feature
set via a rich service oriented architecture (SOA) web services layer allowing organizations to easily
transform static business information into business-aware intelligence.

● RFID Anywhere Label Designer Guide This book describes RFID Anywhere's printing capabilities
and its Label Designer, a graphical tool used to design the layout of RFID and barcode labels.

Visit http://www.ianywhere.com/developer/product_manuals/rfid_anywhere/index.html to obtain the latest
version of the RFID Anywhere documentation.

About this book
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Finding out more and providing feedback
Finding out more

Additional information and resources, including the RFID Anywhere Developer Community, are available
at http://www.sybase.com/products/rfidsoftware/rfidanywhere.

Feedback
We would like to receive your opinions, suggestions, and feedback on this documentation.

You can email comments and suggestions to the RFID Anywhere documentation team at
iasdoc@ianywhere.com. Although we do not reply to emails sent to this address, we read all suggestions
with interest.

Finding out more and providing feedback
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Part I. Getting Started with Enterprise
Manager

This part provides an introduction to Enterprise Manager and its usage.





CHAPTER 1

Getting Started with Enterprise Manager

Contents
Enterprise Manager overview ........................................................................................ 4
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Enterprise Manager overview
RFID Anywhere includes a web-based administrator console that runs on each RFID Anywhere node,
exposing management capabilities for each individual site. Enterprise Manager, however, enables the
management of multiple RFID Anywhere nodes from a central location, which is imperative in multi-site,
distributed RFID networks.

Enterprise Manager is a rich, standalone console that provides a single view of the entire RFID network.
The Enterprise Manager service is installed on dedicated computer, and its console is downloaded and
accessed by a web browser from any computer.

To facilitate this distributed management, Enterprise Manager communicates with one RFID Anywhere Site
Manager using secure web services over HTTP, thus requiring only one integration point, and leveraging
secure communication standards for the delivery of management commands and catalogs, which summarize
the components on each RFID Anywhere node.

During the first communication between a Site Manager and Enterprise Manager, certificates are exchanged.
From then on, all messages between Enterprise Manager and a Site Manager are signed, with certain
messages also being encrypted.

After Enterprise Manager sends commands to a Site Manager, the Site Manager then provides
communication and management message routing into other RFID Anywhere nodes in the network, if
required.

Site Managers also send heartbeat messages to Enterprise Manager to indicate the status of the Site Manager
and any nodes underneath it. Enterprise Manager requests updated catalogs from the Site Manager when
needed, so the catalogs are not sent on every heartbeat. For example, Enterprise Manager may request the
latest catalog from a Site Manager if it noticed that a Component Manager was down, or if a service on
another node was restarted.

In a distributed RFID network, management is simplified through profiles and groups, enabling repeatable
configurations and providing the ability to manage multiple, similar nodes or components together, instead
of one-at-a-time. From Enterprise Manager, administrators can define configuration groups and profiles,

Getting Started with Enterprise Manager
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and apply settings to group members. Here, a group is a set of RFID Anywhere nodes that have something
in common, whether it be location, or components that are installed on them. This group-based management
enables the enforcement of policies and repeatable configurations. Administrators can also define different
views for different administrators, showing each administrator only what he or she needs to see. For example,
a business manager may only presented with configuration of business modules and not hardware connectors.

For more information about the features and benefits of the entire RFID Anywhere technology, see the online
resources at http://www.sybase.com/RFID.

Architecture for flexibility, security, and performance
Enterprise Manager is a dynamic management tool that discovers what needs to be managed and what
properties those items have. This is a vastly different architecture from standard management tools that are
static, requiring configuration and updating to be told what to manage. The dynamic nature of Enterprise
Manager allows new RFID Anywhere nodes to come online, and automatically be managed and configured
with no extra configuration steps in Enterprise Manager. When a Site Manager sends updated catalogs
indicating the status and configuration of each node in a site, Enterprise Manager can consume them and
expose all of the services and properties for management, including properties of custom business modules.

Enterprise Manager is one of the first implementations of Web Services - Management (WS-M),
implementing a number of the standards to facilitate Enterprise Manager's dynamic management capabilities,
asynchronous communication with distributed networks, and data transfer.

The communication between Enterprise Manager and a Site Manager is secure and asynchronous, and
accomplishes the following:

● DISCOVER the presence of resources to be managed
● GET, PUT, CREATE, and DELETE individual resources to be managed
● ENUMERATE the properties of resources to be managed
● SUBSCRIBE to events emitted by resources to be managed, such as heartbeat messages
● EXECUTE specific management commands with strongly typed parameters

The following WS-M standards are used to facilitate the above management tasks:

● WS-Addressing
● WS-Security
● WS-Queuing

The communication between the Enterprise Manager Console running on a PC and the Enterprise Manager
server uses the following WS-M standards:

● WS-Security
● WS-MetadataExchange
● WS-Addressing
● WS-Eventing
● WS-Enumeration
● WS-Transfer

Enterprise Manager overview
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Part II. Installing Enterprise Manager

This part provides installation instructions for Enterprise Manager and the Enterprise Manager Console.





CHAPTER 2

Installing Enterprise Manager

Contents
Installing Enterprise Manager support into RFID Anywhere ........................................ 10
Installation instructions for the Enterprise Manager Console (UI) ............................... 18
Uninstalling Enterprise Manager ................................................................................. 19
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Installing Enterprise Manager support into RFID
Anywhere

The following steps are required to install and run Enterprise Manager on a computer running RFID
Anywhere:

1. Install RFID Anywhere 3.5.1. See “Installing RFID Anywhere” [RFID Anywhere Getting Started
Guide].

2. From the Provisioning page of RFID Anywhere, check to see if the package Enterprise Manager Support
version 3.1.0.25 is listed with a status of Installed in the packages list.

If this package is not installed on your system, proceed to step 3.

If this package is already installed on your system, proceed to “Verifying security certificate
permissions” on page 14.

3. From the Provisioning page of RFID Anywhere, deploy the Enterprise Manager support files
(SetupEMSupport.3.1.0.25.msi), which can be found in the EnterpriseManager directory of the RFID
Anywhere download package.

Note
This step must be performed on the Site Manager computer that communicates with Enterprise Manager.
It must also be installed on Group Manager and Component Manager nodes to be managed by Enterprise
Manager through a Site Manager.

Prerequisites for installing Enterprise Manager
This section explains how to install Enterprise Manager's prerequisites.

Note
If you are installing Enterprise Manager on a computer already running RFID Anywhere successfully, these
prerequisites should already be correctly installed.

System requirements
You need the following to install Enterprise Manager:

● 512 MB RAM

● 2 GHz processor

● Windows XP Professional SP2 or Windows Server 2003 SP1

● Microsoft Internet Information Services

● Microsoft .NET Framework 1.1 SP1, Microsoft .NET Framework 2.0, including ASP.NET.

Installing Enterprise Manager
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● Microsoft Web Services Extensions 2.0 SP3

Installing IIS
RFID Anywhere uses IIS to host the ASP.NET pages for the Administrator Console and to expose web
services to other applications.

To determine if IIS is already installed on your computer

1. From the Start menu, choose Settings » Control Panel.

The Control Panel appears.

2. Double-click Add Or Remove Programs.

The Add Or Remove Programs window appears.

3. On the left side of the Add Or Remove Programs window, click Add/Remove Windows
Components.

The Windows Components Wizard opens.

4. Select Internet Information Services (IIS), and then click Details.

5. If the Common Files, Documentation, Internet Information Services Snap-in, and World Wide Web
Service components are selected, then the necessary IIS components are already installed on your
computer. Follow the instructions below to verify that IIS is functioning correctly. If the above
components are not selected, follow the instructions below to install IIS on your computer.

To install IIS on your computer

1. From the Start menu, choose Settings » Control Panel.

The Control Panel opens.

2. Double-click Add Or Remove Programs.

The Add Or Remove Programs window appears.

3. On the left side of the Add Or Remove Programs window, click Add/Remove Windows
Components.

The Windows Components Wizard opens.

4. Select Internet Information Services (IIS), and then click Details.

5. Ensure the Common Files, Documentation, Internet Information Services Snap-in, and World Wide
Web Service components are selected are selected to be installed, and then click OK.

6. Follow the instructions in the wizard, insert your Windows CD if prompted, and click Finish when the
wizard completes.

To determine that IIS is functioning correctly

1. Open the Control Panel by choosing Start » Settings » Control Panel.

2. Double-click Administrative Tools.

Installing Enterprise Manager support into RFID Anywhere
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3. Double-click Services.

4. Ensure that the following services have a Status of Started, and that their Startup Type is set to
Automatic:

● IIS Admin
● World Wide Web Publishing

5. From a web browser, navigate to http://localhost. An Under Construction page or custom web site should
appear.

For more information about troubleshooting IIS issues, see the online resources at http://
www.microsoft.com.

Installing the .NET Framework
The Microsoft .NET Framework 1.1 SP1 and 2.0 is used to enable the ASP.NET pages of the Administrator
Console and to provide additional tools and libraries for RFID Anywhere and custom business logic.

Note
If the Administrator Console does not display or function correctly after installation, often with code being
displayed instead of typical HTML forms, it may indicate that this step did not complete successfully. If this
occurs, follow these steps again, ensuring that previous versions are removed and all steps are followed.

Uninstall existing versions of the .NET Framework from your computer

● Open the Control Panel, then click Add Or Remove Programs and uninstall any previous versions of
the Microsoft .NET Framework from your computer, including version 1.1.

To install the .NET Framework 1.1 SP1 on your computer

1. Download and execute the Microsoft .NET Framework version 1.1.4322 Redistributable Package from
http://www.microsoft.com/downloads/details.aspx?FamilyID=262d25e3-
f589-4842-8157-034d1e7cf3a3&displaylang=en.

2. Run the following command from C:\WINDOWS\Microsoft.NET\Framework\v1.1.4322\ to ensure that
ASP.NET for IIS is enabled:

aspnet_regiis.exe –I
3. Download and execute the Microsoft .NET Framework 1.1 Service Pack 1 package (KB867460) from

http://www.microsoft.com/downloads/details.aspx?FamilyID=a8f5654f-088e-40b2-bbdb-
a83353618b38&displaylang=en. Restart your computer if you are prompted.

4. Verify the user permissions of the automatically-created ASP.NET Machine Account:
a. Navigate to your Windows folder, typically C:\Windows. This account needs full permission to the

Windows Temp folder.
b. Right-click the Temp folder and choose Properties.
c. On the Security tab, highlight the ASP.NET Machine Account user.

Installing Enterprise Manager
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d. If the user is not in the list, add the account by clicking Add.
e. In the Locations field, select your computer name, and then enter ASPNET in the object names field

and click Check Names before clicking Add.
f. With the ASPNET user selected, select the Full Control checkbox under Allow, and then click

OK.

To install the .NET Framework 2.0 on your computer

● Download and execute the Microsoft .NET Framework 2.0 redistributable package from http://
www.microsoft.com/downloads/details.aspx?FamilyID=0856eacb-4362-4b0d-8edd-
aab15c5e04f5&displaylang=en. Restart your computer if you are prompted.

Installing WSE 2.0 SP3
Microsoft Web Services Extensions (WSE) 2.0 SP3 for Microsoft .NET is used to enable web services from
RFID Anywhere.

To determine if WSE 2.0 SP3 is installed on your computer

1. From the Start menu, choose Settings » Control Panel.

The Control Panel opens.

2. Double-click Add Or Remove Programs.

TheAdd Or Remove Programs window opens.

3. Verify that Microsoft WSE 2.0 SP3 is in the list of currently installed programs. If it is, WSE 2.0 SP3 is
installed on your computer. If it is not, follow the instructions below to install WSE 2.0 SP3 on your
computer.

To install WSE 2.0 SP3 on your computer

1. Download and execute the Microsoft Web Services Extensions 2.0 SP3 for Microsoft .NET package
from http://www.microsoft.com/downloads/details.aspx?familyid=1ba1f631-c3e7-420a-bc1e-
ef18bab66122&displaylang=en.

2. Click Next to proceed.

3. Read and accept the terms in the license agreement, and then click Next.

4. Select Administrator to install the runtime files and standalone tools, and then click Next.

5. Click Install to proceed with the installation.

6. Click Finish once the installation completes. Close any windows that appear.

Installing Enterprise Manager
This section explains how to install Enterprise Manager's server component.

Installing Enterprise Manager support into RFID Anywhere
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To install Enterprise Manager's server component

1. Download the RFID Anywhere installation package.

2. Extract the ZIP file you downloaded to your desktop or a temporary location.

3. In the directory where you extracted the RFID Anywhere installation, open the EnterpriseManager
folder.

4. Double-click RAEM-version.msi.

The RFID Anywhere Enterprise Manager Setup Wizard opens. Click Next.

5. Select the country where you are installing the software. Click Next.

6. Choose whether you agree to the License Agreement.

You must agree to the RFID Anywhere License Agreement before you can proceed with the installation.

7. Enter the Order Number, Feature Name, and Authorization Code from your RFID Anywhere license,
and then click Next.

8. Enter your name and organization in the respective fields on the Customer Information window, and
choose to install RFID Anywhere for all users of the computer, or only for yourself.

9. Select Complete to install all components of RFID Anywhere Enterprise Manager in the default directory
of C:\Program Files\Sybase\RFID Anywhere Enterprise Manager. To change the installation directory,
select Custom. Click Next.

10. If you selected Custom, specify the installation directory for RFID Anywhere. Click Next.

11. Click Install to begin the installation.

12. Click Close when the installation completes.

RFID Anywhere Enterprise Manager is now installed on your computer.

Verifying security certificate permissions
Both RFID Anywhere and RFID Anywhere Enterprise Manager generate X.509 certificates to enable secure
communication. If you plan on accessing Enterprise Manager as a user other than the user you install RFID
Anywhere and Enterprise Manager as (for example, a local Administrator user), ensure that account has
permissions on the certificates.

To verify that the correct security certificate permissions are in place

1. If you correctly selected Administrator when installing Microsoft WSE 2.0 SP3, the X509 Certificate
Tool is installed on your system.

Note
If you only installed the Runtime version of WSE 2.0 SP3, click the Change button underneath Microsoft
WSE 2.0 SP3 from Add/Remove Programs and choose to install the Tools components.

2. Choose Start » Programs » Microsoft WSE 2.0 » X509 Certificate Tool.

Installing Enterprise Manager
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3. In the Certificate Location field, select Local Computer. In the Store Name field, select Personal.
Click Open Certificate.

4. Select the certificate in the list named RFID Anywhere Enterprise Manager, then click OK.

5. The Certificate Properties and Key Identifiers sections of the WSE X.509 Certificate tool are
populated. Click the View Private Key File Properties button.

6. On the Security tab, click Add. Ensure that the From This Location field is correct (it should be your
computer name for a local Administrator account), enter the username, and click OK.

7. Follow the steps above to ensure the correct permissions for the certificate named RFID Anywhere.

Installing Enterprise Manager support into RFID Anywhere
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Upgrading and backing up Enterprise Manager
This section explains how to upgrade a previous version of Enterprise Manager to version 3.5, which involves
using a tool to back up and restore Enterprise Manager configuration information. It also discusses how to
back up an Enterprise Manager server.

To upgrade Enterprise Manager

1. Upgrade all sites that are managed by Enterprise Manager to RFID Anywhere 3.5, including the 3.5
version of the EMSupport package.

2. Installed the EM Backup tool by double-clicking SetupEMBackup.msi from the EnterpriseManager
folder of your installation package.

3. Launch the EMBackup tool from Start » Programs » iAnywhere.RfidNet.EMBackup and back up
your Enterprise Manager configuration.

4. Uninstall the previous version of Enterprise Manager.

5. Install the 3.5 version of Enterprise Manager.

6. Relaunch the EMBackup tool and restore the previously-saved Enterprise Manager configuration. Click
Yes to upgrade database. A confirmation message appears.

7. Log in to Enterprise Manager and confirm that all the settings were updated correctly.

To back up Enterprise Manager

● Use the EMBackup tool to create a backup your current Enterprise Manager configuration..

Connecting an RFID Anywhere Site Manager to Enterprise
Manager

This section explains how to connect an RFID Anywhere Site Manager to Enterprise Manager.

To connect an RFID Anywhere Site Manager to Enterprise Manager

1. From the RFID Anywhere Site Manager's Administrator Console Configuration tab, click the Server
tab and specify the Network Connection to use from the System pane on the left side of the Server
Configuration page.

Note
If you do not correctly indicate which network connection RFID Anywhere is using, you get a No
network connection specified error in the Enterprise Manager pane, and the Register
button is greyed-out. After setting this, you have to refresh your browser window to enable the
Register button.

2. From the RFID Anywhere Site Manager's Administrator Console Configuration » Server page, enter
username and password credentials and click Register to set up a connection between Enterprise
Manager and the Site Manager.

Installing Enterprise Manager
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Notes
Credentials for an account in the Administrators group on the Enterprise Manager computer is
recommended for the initial communication. An alternate Managers group can be specified from
Enterprise Manager afterwards.

If Enterprise Manager is installed on the same computer an the RFID Anywhere Site Manager, the Site
Manager is only able to connect to the local Enterprise Manager, as the host information on the Server
Configuration page is pre-populated.

3. Clicking Register displays a prompt asking you to verify that you want to register this Site Manager
with Enterprise Manager. Click OK.

Note
When a Site Manager has delegated its administration to an Enterprise Manager, the Local Services list
from the Site Manager’s Administrator Console becomes read-only. You can view the properties of a
service, but cannot add/remove services, start/stop services or modify service properties, as all
management must be done from Enterprise Manager.

Unregistering a Site Manager
After successfully registering a Site Manager to Enterprise Manager, the Console Configuration page
displays the connection details and the Unregister button. To sever connector and unregister, you have to
provide credentials.

To unregister a Site Manager from Enterprise Manager

● From the RFID Anywhere Site Manager's Administrator Console Configuration page, enter username
and password credentials and click Unregister to sever the connection between Enterprise Manager and
the Site Manager.

Installing Enterprise Manager support into RFID Anywhere
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Installation instructions for the Enterprise Manager
Console (UI)

This section outlines how to install the Enterprise Manager Console, or User Interface (UI), on a computer
that is to access Enterprise Manager to manage an RFID network.

Installing the Enterprise Manager Console
To install the Enterprise Manager Console

1. To install the Enterprise Manager Console in the same computer as Enterprise Manager, browse to http://
localhost/RFIDAnywhereEnterpriseManager/.

If this is your first time accessing the Enterprise Manager Console from the computer, you must click
the Install Enterprise Manager Prerequisites link to download and install a trust application called
RAEMUITrust.msi. Accept the installation. This needs to be done on any computer that accesses the
Enterprise Manager Console, but it only needs to be done once per computer.

2. Once the trust application is installed, browse to http://localhost/RFIDAnywhereEnterpriseManager/ and
click the Enterprise Manager link.

3. Log in to the Enterprise Manager Console with credentials for a local administrator account on the
Enterprise Manager computer.

Installing Enterprise Manager
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Uninstalling Enterprise Manager
To uninstall Enterprise Manager, and to uninstall the Enterprise Manager console from any computer where
it has been installed, use the Control Panel.

To uninstall Enterprise Manager

1. Choose Start » Programs » RFID Anywhere Enterprise Manager » Stop Service.

2. Once the Enterprise Manager service stops, go to Control Panel » Add or Remove Programs.

3. Select RFID Anywhere Enterprise Manager and click Remove.

The Enterprise Manager is uninstalled and removed.

To uninstall the Enterprise Manager Console from any computer where it has been installed

1. Open the Control Panel and choose Add Or Remove Programs.

2. Select RFID Anywhere Enterprise Manager UI Trust and click Remove.

The Enterprise Manager Console is uninstalled and removed.

Uninstalling Enterprise Manager
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Part III. Using Enterprise Manager

This part contains detailed instructions for using Enterprise Manager to manage your RFID Anywhere network.
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Using Enterprise Manager
The first time Enterprise Manager is accessed with Administrator privileges, you are redirected to the
Enterprise Manager Configuration page. Click the Edit Properties icon in the System Configuration
section to edit the properties.

Click the . beside the Enterprise Manager IP property. Use the dropdown list to select the IP address that
Enterprise Manager should use. All available IP addresses are listed. After selecting the desired IP address,
click Save.

The Sites view
The Sites view of the Enterprise Manager Console lists all RFID Anywhere sites that have set up their
connection to this Enterprise Manager. Recall that a site is a collection of RFID Anywhere nodes, all managed
by Enterprise Manager through a single Site Manager. The nodes in a site include the Site Manager node,
and any Group or Component Manager nodes under that Site Manager.

Right-click an RFID Anywhere site to perform common tasks:

● Refresh Sites to update the Last Communication column

● Edit Site to configure the sites available schedule for processing tasks if the site is not always available

● Ping Site to instruct the Site Manager to send an updated catalog

● Remove Site to stop managing the site

● Apply Profile To Site to launch the process of assigning a specific profile to the nodes of the site

Using Enterprise Manager
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The Nodes view
The Nodes view shows a tree structure of all nodes (Site Managers, Group Managers, and Component
Managers) that are controlled by Enterprise Manager.

Right-click an RFID Anywhere node to perform common tasks:

● Refresh Nodes to update the Last Communication column

● Edit Node to configure the local services running on the node and to manage users in the nodes
RfidManagers or RfidWebServiceUsers groups

● Remove Node to delete the Node from the network

● Ping Node to instruct the node to send an updated catalog via its Site Manager

● Apply Profile to apply a profile to the node or to a service on the node

Using Enterprise Manager
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Editing a node
To edit services of a node

1. Right-click a node from the Nodes view and choose Edit Node.

A window opens showing the properties of the node.

2. Click Services, then the ellipsis (…) to bring up the Services view.

Note
If a warning message appears indicating that the node information for the node you selected is not
available, click the green checkmark to acknowledge the message, then right-click the node and choose
Ping Node to force the node to send its information to Enterprise Manager.

3. The Services window shows the local services installed on the node. Icons indicate if a service is running
or not. You can do to following common tasks from the Services list of a node:

● Use the Add>package name button to create a new instance of a service (package must already be
deployed to node)

● Use the Remove button to remove a service
● Click a service and click Start or Stop to start or stop the service
● Click a service and update properties in the right pane to modify a service

Using Enterprise Manager
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4. Once all modifications are complete, click OK, then click Save to save the changes and push them down
to the Site Manager (if the Site Manager is connected) or queue them up to be delivered the next time
the Site Manager connects.

To manage users on a node

1. Right-click a node from the Nodes view and choose Edit Node.

A window opens showing the properties of the node.

2. Click Roles, then the ellipsis (…) to bring up the Roles\Users view.

Note
If a warning message appears indicating that the node information for the node you selected is not
available, click the green checkmark to acknowledge the message, then right-click the node and choose
Ping Node to force the node to send its information to Enterprise Manager.

3. The Roles\Users list shows the two RFID Anywhere-specific groups of users for an RFID Anywhere
node. RfidManagers and RfidWebServiceUsers. You can do the following tasks from the Roles\Users
list of a node:

Using Enterprise Manager

Copyright © 2008, iAnywhere Solutions, Inc. 27



● Right-click a group and choose Add User to bring up properties for a new user, which are created
on the system after user properties are entered.

● Right-click a user in a group and choose Remove User From Group to remove the user from the
group, but keep the user account on the node with any other group memberships it had.

● Right-click a user in a group and choose Delete user to delete the user account from the node.

The Groups view
The Groups view allows administrators to manually create groups of sites, groups of nodes, groups of
services, and groups of profiles to simplify the updates of multiple components on different sites.
Specifically, the Provisioning view allows you to deploy updates by group.

To create a new group in one of the group categories (Site, Node, Service, Profile)

● Right-click the group category and choose Add Group.

Right-clicking a previously created group exposes the following options:

● Refresh to update the group display

● Add Group to add a new group of the same type

● Edit Group to update the group membership and properties

● Delete Group to delete the configured group

The Profiles view
The Profiles view allows an administrator to define property values for a service type that can be applied to
an enforced on services running on other nodes.
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To add a new profile

1. Right-click All Profiles and choose Add Profile.

The Create Profile screen appears.

2. On the Create Profile screen, give the new profile a name and description, and then select the type of
service this profile is for. The Type dropdown list is populated with all services installed on one or more
nodes.

3. After the Name, Description, and Type fields are filled, the Available Properties window is populated
with the properties used to configure services of that type. An administrator can choose to enforce values
of any number of the properties. Properties to be managed are moved to the right side of the Create
Profile window using the arrow icons, and the property values can then be set.

4. Click Save to save the new profile.

5. Once a profile is created, it can be applied to the services of a node from the Site or Node view.

By right-clicking a site from the Site view and choosing Apply Profile To Site, and then selecting a
profile, that profile is applied to all services of that type running on all nodes under that site. By right-
clicking a node from the Node view and choosing Apply Profile » Apply to Node, and then selecting
a profile, that profile is applied to all services of that type running on the node. By choosing Apply
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Profile » Apply to Service from the Node view, an administrator can target a specific service instance
with the profile.

The Tasks view
The Tasks view outlines the changes you made from the Node view and summarizes the pending tasks.

The Provisioning view
The Provisioning view allows an administrator to view, install and uninstall packages to RFID Anywhere
nodes. A package is an .msi file that contains an RFID Anywhere component to be deployed. These are the
same packages, most often hardware connectors, that are installed by the RFID Anywhere Administrator
Console's Provisioning page.

The Package View tab in the Provisioning view shows a list of all packages installed on RFID Anywhere
nodes. Clicking a package shows you what versions are installed on what nodes.

The Package View tab in the Provisioning view shows a list of all RFID Anywhere packages installed on
ore or more nodes. Clicking a package displays all of the nodes that have that specific package installed.

The Node View tab in the Provisioning view shows a list of all RFID Anywhere nodes. Clicking a node
displays the packages, including version, installed on the node. This is similar to the Provisioning page of
the Site Manager.

Installing new packages
The New Package icon allows you to deploy a new package to a site (or to nodes, or groups of nodes).

To install a new package

1. Click the New Package icon on the Provisioning page.

2. Use the Filter dropdown list to narrow the list of targets to Sites (which automatically deploys the
package to all nodes managed by that site), Nodes (to deploy packages to individual nodes), or
Groups (to deploy to a previously-defined group of sites or nodes).

3. Specify the Deployment Schedule.

4. Browse to the package to be deployed, and click Deploy.
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After deploying a package, go to the Tasks view to see pending tasks and to see the status of completed
tasks.

Deploying files
Enterprise Manager can allow an administrator to deploy files from the Enterprise Manager console to RFID
Anywhere sites or nodes using the Deploy Files icon from the Provisioning page. These files could be data
files used by a business module, or a firmware upgrade for a hardware connector.

To deploy a file

1. Click the Deploy File icon on the Provisioning page.

2. Use the Filter dropdown list to narrow the list of targets to Sites (which automatically deploys the
package to all nodes managed by that site), Nodes (to deploy packages to individual nodes), or
Groups (to deploy to a previously-defined group of sites or nodes).

3. Specify the Deployment Schedule.

4. Browse to the file to be deployed.

5. Select the type of service you are deploying the file to. This pre-populates the install path for you.

6. If you want to specify a different directory, update the install path field.

Note
Note that all deployed files are placed somewhere under the Data\Files folder of the node's RFID
Anywhere installation directory, usually organized by component GUID.
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7. Click Deploy.

After deploying a file, go to the Tasks view to see pending tasks and to see the status of completed tasks.

The Configuration view
The Configuration view allows an administrator to update the properties of the Enterprise Manager.

The following properties can be managed from the Configuration view:

● Administration Domain Specifies the domain that administrators are authenticated against.

● Administration Group Users must be part of this group in the Administration Domain to have
administrator privileges in Enterprise Manager.

● Enterprise Manager IP The IP address (and associated network card) Enterprise Manager uses.

● Language The Language the Enterprise Manager Console displays. English is the only language
currently supported.

● Registration Domain Specifies the domain that registration credentials from Site Managers are
authenticated against.

● Registration Group Users must be part of this group in the Registration Domain to register a Site
Manager to this Enterprise Manager.

● Site Manager Retries The number of times Enterprise Manager should attempt to connect to a Site
Manager.

● Site Manager Timeout The time, in minutes, to wait between Site Manager retries.

The Monitoring view
The Monitoring view shows all Enterprise Manager status messages. The verbosity of the messages is
controlled from the Trace Level property on the Configuration view.

The Admin view
The Admin view allows an administrator to set role permissions for other administrators, including the
ability to view, create, edit, or delete RFID Anywhere components such as business modules or connectors.
Specific roles can also be defined so that certain administrators only have permission to manage certain sites.

Logging out
Click the Logout icon to log out of the Enterprise Manager Console.
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Troubleshooting
This section outlines potential errors or issues you may encounter when using Enterprise Manager to manage
your RFID Anywhere network, and how to resolve them.

Firewall issues
RFID Anywhere and Enterprise Manager communicate over HTTP, so firewall issues are rare. To
troubleshoot issues communicating from Enterprise Manager to a Site Manager, ensure that you can access
the Site Manager's RFID Anywhere Administrator Console (http://SiteManagerIP/rfidanywhere) from a web
browser on the Enterprise Manager computer.

Similarly, ensure that you can access Enterprise Manager's main page (http://EnterpriseManagerIP/
rfidanywhereenterprisemanager) from a web browser on the Site Manager computer, and from a web browser
on any machine where the Enterprise Manager console is used.

Authentication Failed errors
If you see Authentication Failed errors in the Enterprise Manager Monitoring page, ensure that the RFID
Anywhere node contains both X.509 certificates and that the permissions are set correctly. See “Verifying
security certificate permissions” on page 14.

404 - File not found errors
If you see AsynchronousOperationException error messages whose details indicate a 404 (File not found)
error when attempting to access RFIDSite.ashx on the Site Manager computer, ensure that the following line
is included in the <httpHandlers> section of the install-dir/Web.config file:

<add verb="*" path="RFIDSite.ashx" 
type="iAnywhere.RfidNet.Management.MngWSEService, 
iAnywhere.RfidNet.Management.WSE"/>

For these errors, also ensure that the Temp folder in your Windows directory exists, and that the local user
named ASPNET, used by the .NET Framework, has both read and write privileges on the folder.

403 - Access denied errors
If you see 403 - access denied errors when communicating with Enterprise Manager from the Enterprise
Manager console, or from Enterprise Manager to a Site Manager, restart the Windows service named IIS
Admin to restart IIS and the aspnet_wp process. This error may occur when too many users are connected
to IIS.
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Building a network
To build the distributed RFID Anywhere network required by a solution, administrators, developers, and
integrators must first design the network, including what nodes run hardware connectors, how business logic
is distributed, and where enterprise integration occurs. Once the design is complete, RFID Anywhere nodes
can be installed and their relationships set up to create the distributed network.

To ensure that each node can be managed by Enterprise Manager, the Enterprise Manager support package
must first be installed, and each Group Manager and Component Manager node must use their Configuration
page to specify which Site Manager they are connected to. By establishing the connection with a Site
Manager, the Site Manager communicates with Enterprise Manager on the node's behalf.
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